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�WICZENIE 3
Wprowadzenie do ±rodowiska Simulink.

Celem ¢wiczenia jest poznanie podstawowych cech ±rodowiska symulacyjnego Matlab Simulink.

1 Wprowadzenie

Simulink jest specy�cznym moduªem rozszerzaj¡cym pakietu Matlab, sªu»¡cym do modelowania,
symulacji i analizy dynamicznych obiektów rzeczywistych. Wspiera modele liniowe i nieliniowe,
dyskretne lub ci¡gªe w czasie, a tak»e stanowi¡ce hybryd¦ tych dwóch rodzajów. Mo»na tworzy¢
tak»e modele zawieraj¡ce elementy o ró»nych okresach próbkowania.

Tworzenie modeli rzeczywistych obiektów i ich analiza w Simulinku dokonywane s¡ za po±red-
nictwem interface'u gra�cznego, w ramach którego system modelowany jest w postaci schematu
blokowego, tzn. przez wybór i ª¡czenie bloków, udost¦pnianych w ramach pakietu Simulink. Do
standardowego zbioru tych elementów nale»¡ biblioteki komponentów wizualizacyjnych, modeluj¡-
cych czªony liniowe i nieliniowe oraz generuj¡cych sygnaªy ¹ródªowe.

Bloki, z których tworzy si¦ model systemu, reprezentuj¡ elementarne systemy dynamiczne, któ-
rych dziaªanie i sposób symulacji Simulink inherentnie zna. W ogólno±ci blok posiada¢ mo»e: zbiór
wej±¢, zbiór stanów i zbiór wyj±¢. Warto±ci pojawiaj¡ce si¦ na wyj±ciach bloku s¡ funkcj¡ czasu i
warto±ci wej±ciowych oraz zmiennych stanu (o ile dany blok jest w nie wyposa»ony). Konkretna
funkcja zale»y od typu u»ytego bloku.

Kluczowe wªa±ciwo±ci wielu standardowych bloków zostaªy sparametryzowane. Dzi¦ki temu
mo»na ªatwo okre±la¢ i dostosowywa¢ cechy u»ytych komponentów na etapie tworzenia modelu (a
niektóre tak»e w czasie trwania symulacji).

W Simulinku istnieje mo»liwo±¢ modelowania zªo»onych systemów w postaci szeregu poª¡czo-
nych ze sob¡ podsystemów, z których ka»dy symbolizowany jest pojedynczym blokiem i reprezentuje
pewien fragment schematu blokowego, stanowi¡cy funkcjonaln¡ caªo±¢. Takie podsystemy mo»na
u»ywa¢ jako skªadniki innych, bardziej zªo»onych (pod-) systemów, uzyskuj¡c w efekcie modele
hierarchiczne.

Zadaniem niniejszego ¢wiczenia jest zapoznanie si¦ z podstawowymi cechami ±rodowiska Simu-
link oraz sposobu wykorzystywania standardowych skªadników.

Simulink mo»na uruchomi¢ z poziomu okna polece« Matlaba, wydaj¡c polecenie simulink, lub
klikaj¡c na reprezentuj¡c¡ go ikon¦ w menu narz¦dziowym gªównego okna Matlaba (Rys. 1). Po
uruchomieniu uka»e si¦ gªówne okno przegl¡darki bibliotek Simulinka (Simulink Library Browser),
z którego mo»na uzyska¢ dost¦p do wszystkich bloków wykorzystywanych do tworzenia modelu.

1.1 Uruchomi¢ ±rodowisko Simulink.
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Rysunek 1: Ikona uruchamiaj¡ca ±rodowisko Simulink.

2 Tworzenie nowego modelu

Aby rozpocz¡¢ tworzenie nowego modelu z menu File nale»y wybra¢ opcj¦ New→Model lub klikn¡¢
na ikon¦ nowego dokumentu na pasku narz¦dziowym. Spowoduje to wy±wietlenie nowego okna, w
obr¦bie którego tworzony b¦dzie model.

2.1 Wskazówki do tworzenia modelu

Tworzenie prostego modelu skªada si¦ z nast¦puj¡cych kroków:

• umieszczenie odpowiednich bloków w modelu;

• przestawianie bloków w modelu;

• ª¡czenie bloków ze sob¡;

• zapisywanie modelu.

Umieszczenie bloku w modelu wymaga umiej¦tno±ci odnajdowania bloku w przegl¡darce bibliotek.
Dost¦p do poszczególnych bloków mo»na uzyska¢ rozwijaj¡c i wybieraj¡c pozycje w gªównym oknie
przegl¡darki bibliotek Simulinka. Przykªadowo blok generuj¡cy sygnaª sinusoidalny (Sine Wave)
znajduje si¦ w bibliotece Sources (Rys. 2). Dokªadny opis zawarto±ci poszczególnych bibliotek
przedstawiono w nast¦pnym podrozdziale.

Rysunek 2: Widok okna przegl¡darki bibliotek Simulink oraz wn¦trze biblioteki ¹ródeª.
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Wybrane bloki nale»y przenie±¢ do tworzonego modelu przeci¡gaj¡c je myszk¡ (metoda drag-
and-drop) z okna Simulink Library Browser do okna modelu. Parametry bloków mo»na zmienia¢
po dwukrotnym klikni¦ciu ikony bloku.

Zanim bloki zostan¡ poª¡czone, nale»y rozmie±ci¢ je w taki sposób w oknie modelu, aby poª¡-
czenie sygnaªów byªo mo»liwie jak najczytelniejsze. Aby przemie±ci¢ blok nale»y przeci¡gn¡¢ go
myszk¡ (metoda drag-and-drop) lub zaznaczy¢ blok lewym przyciskiem myszy i przestawia¢ go za
pomoc¡ strzaªek na klawiaturze.

Po prawidªowym rozmieszczeniu bloków modelu, nale»y utworzy¢ poª¡czenia pomi¦dzy nimi,
reprezentuj¡ce poª¡czenia sygnaªów modelu. Nale»y zwróci¢ uwag¦ na symbole doª¡czone z jednej
lub obu stron ka»dego z bloków. Oznaczaj¡ one porty wej±ciowe lub wyj±ciowe bloku:

• symbol > wskazuj¡cy na blok jest portem wej±ciowym;

• symbol > wskazuj¡cy na zewn¡trz bloku jest portem wyj±ciowym.

Aby utworzy¢ poª¡czenie pomi¦dzy dwoma blokami, nale»y umie±ci¢ kursor myszy nad portem
wej±ciowym (lub wyj±ciowym) bloku. Kursor myszki zamieni si¦ wówczas na znak plus (+). Przy
wci±ni¦tym lewym przycisku myszy nale»y przeci¡gn¡¢ kursor do portu wyj±ciowego (lub wej±cio-
wego) drugiego bloku. Lewy przycisk myszy nale»y zwolni¢ dopiero w momencie, gdy kursor zamieni
si¦ na pogrubiony znak plus (+). Poª¡cze« nigdy nie tworzy si¦ pomi¦dzy portami tego samego
rodzaju (wej±ciowego z wej±ciowym oraz wyj±ciowego z wyj±ciowym).

Je»eli jeden port wyj±ciowy ma by¢ poª¡czony z dwoma portami wej±ciowymi, wówczas mo»liwe
jest utworzenie rozgaª¦zienia. Nale»y utworzy¢ pierwsze poª¡czenie, a nast¦pnie wybra¢ je prawym
przyciskiem myszy (lub lewym z wci±ni¦tym klawiszem Ctrl) w celu utworzenia drugiego poª¡czenia.
Mo»liwe jest równie» wytworzenie poª¡czenia pomi¦dzy portem wej±ciowym a ±rodkiem linii ª¡cz¡cej
dwa inne bloki.

Przykªadowy gotowy model przedstawiono na Rys. 3.

Rysunek 3: Przykªadowy model Simulinka.

Podczas tworzenia modelu przydatne mo»e okaza¢ si¦ stosowanie znanych skrótów klawiszo-
wych (Ctrl+C, Ctrl+V, Ctrl+Z). Dodatkowo zastosowanie klawisza Del usuwa zaznaczony element
modelu. Poª¡czenie klawiszy Ctrl+R obraca orientacj¦ zaznaczonego bloku.

Przydatne mo»e okaza¢ si¦ zaznaczanie wielu obiektów modelu naraz. Wystarczy obj¡¢ od-
powiednie elementy bryª¡ brzegow¡. Nale»y najpierw okre±li¢ pocz¡tkowy róg prostok¡ta, przez
odpowiednie ustawienie kursora myszy oraz naci±ni¦cie lewego przycisku. Przytrzymuj¡c lewy
przycisk myszy, nale»y przeci¡gn¡¢ kursor do przeciwlegªego rogu prostok¡ta oraz zwolni¢ przycisk
myszy. W wyniku tych operacji wszystkie elementy znajduj¡ce si¦ wewn¡trz prostok¡ta, zostan¡
zaznaczone.

Zapis utworzonego modelu odbywa si¦ przez wybranie File→Save z menu okna modelu.
Aby uruchomi¢ symulacj¦ modelu bez zmiany parametrów symulacyjnych (dokªadny opis w pod-

rozdziale 2.3), nale»y wybra¢ opcj¦ menu Simulation→Start, lub nacisn¡¢ przycisk Start Simulation
z paska narz¦dzi.
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2.2 Podstawowe skªadniki ±rodowiska Simulink

Simulink udost¦pnia 16 standardowych bibliotek bloków, Tab. 1 opisuje ka»d¡ z bibliotek. Podczas
laboratoriów z przedmiotu Podstawy Automatyki wykorzystywane b¦d¡ gªównie bloki zawarte w
bibliotekach Commonly Used Blocks, Continuous, Sources oraz Sinks. Wa»n¡ bibliotek¡, która
mo»e si¦ okaza¢ przydatna przy tworzeniu modeli, jest User-De�ned Functions. Blok Matlab Fcn
umo»liwia wykorzystanie funkcji zapisanej przez u»ytkownika w postaci m-pliku. Wystarczy w
oknie parametrów bloku poda¢ nazw¦ funkcji oraz liczb¦ parametrów wyj±ciowych.

Biblioteka Opis zawarto±ci

Commonly Used Blocks Zawiera najcz¦±ciej u»ywane bloki, takie jak Constant,
In1, Out1, Scope. Wszystkie zawarte w tej bibliotece bloki
s¡ cz¦±ciami innych bibliotek.

Continuous Zawiera bloki sªu»¡ce do modelowania funkcji liniowych
(np.Derivative, Integrator).

Discontinuities Zawiera bloki, których wyj±cia s¡ nieci¡gªymi funkcjami
wej±¢ (np. Saturation).

Discrete Zawiera bloki, które reprezentuj¡ funkcje zdyskretyzowane
(np. Unit Delay).

Logic and Bit Operations Zawiera bloki, które dokonuj¡ operacji logicznych lub
bitowych (np. Logical Operator Relational Operator).

LookUp Tables Zawiera bloki, które wykorzystuj¡ lookup tables do
okre±lenia wyj±¢ na bazie wej±¢ (np.Cosine, Sine).

Math Operations Zawiera bloki, które dokonuj¡ operacji matematycznych
(np. Gain, Product, Sum)

Model Veri�cation Zawiera bloki, które umo»liwiaj¡ stworzenie
samo-sprawdzaj¡cych si¦ modeli (np. Check Input
Resolution).

Model-Wide Utilities Zawiera bloki, które dostarczaj¡ informacji o modelu (np.
Model Info).

Ports & Subsystems Zawiera bloki, które umo»liwiaj¡ tworzenie podsystemów
(np. In1, Out1, Subsystem).

Signal Attributes Zawiera bloki, które mody�kuj¡ atrybuty sygnaªów (np.
Data Type Conversion).

Signal Routing Zawiera bloki, które umo»liwiaj¡ sterowanie przepªywem
sygnaªów (np. Mux, Switch).

Sinks Zawiera bloki, które wy±wietlaj¡ lub eksportuj¡ wyj±cia
modelu (np. Out1, Scope).

Sources Zawiera bloki, które wytwarzaj¡ albo importuj¡ wej±cia
modelu (np. Constant, In1, Sine Wave).

User-De�ned Functions Zawiera bloki, które umo»liwiaj¡ wykorzystanie funkcji
stworzonej przez u»ytkownika (np. Matlab Fcn).

Additional Math & Discrete Zawiera dwie dodatkowe biblioteki bloków funkcji
matematycznych i dyskretnych.

Tablica 1: Opis zawarto±ci bibliotek Simulinka.

Cz¦sto do wy±wietlania sygnaªów wykorzystywanych w symulacji, wykorzystuje si¦ blok oscylo-
skopu (Scope). Okno Scope nie jest automatycznie otwierane przy uruchamianiu symulacji w Simu-
linku, mimo tego dane poª¡czone z blokiem s¡ zapisywane. Aby otworzy¢ okno oscyloskopu nale»y
nacisn¡¢ blok dwukrotnie lewym przyciskiem myszy. Je»eli okno oscyloskopu zostanie otwarte ju»
po zako«czeniu symulacji, uzyskane dane zostan¡ wy±wietlone w odniesieniu do czasu symulacji.
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Rysunek 4: Mo»liwo±ci poª¡czenia sygnaªów z blokiem Scope: a. wy±wietlenie wszystkich sygnaªów
na jednym wykresie; b. wy±wietlenie sygnaªów na 3 wykresach.

Rysunek 5: Okno bloku Scope wraz z opisem paska narz¦dzi.

Za pomoc¡ pojedynczego bloku Scope mo»na wy±wietli¢ wi¦cej ni» jeden sygnaª (lub sygnaª
postaci macierzowej). Je»eli wszystkie sygnaªy podª¡czymy do jednego portu wej±ciowego, wów-
czas dane b¦d¡ przedstawione na wspólnym wykresie (Rys. 4 a). W takim przypadku, blok Scope
przypisuje kolor do ka»dego z sygnaªów w kolejno±ci: niebieski, zielony, czerwony, turkusowy, pur-
purowy, »óªty. Je»eli do bloku Scope podª¡czy si¦ wi¦cej ni» 6 sygnaªów (lub sygnaª posiada wi¦cej
ni» 6 kolumn), blok Scope zaczyna przypisywanie kolorów z powrotem od niebieskiego.

Mo»liwe jest równie» zde�niowanie wielu ukªadów wspóªrz¦dnych, na których b¦d¡ prezentowane
wykresy w ramach jednego okna oscyloskopu. W tym celu nale»y wybra¢ Wªa±ciwo±ci oscyloskopu
z menu bloku Scope (Rys. 5), a nast¦pnie ustawi¢ odpowiedni¡ warto±¢ w polu Number of Samples.

Przydatn¡ opcj¡ jest równie» Automatyczne skalowanie, które dobiera skal¦ osi x i y tak, aby
widoczny byª caªy przebieg sygnaªu.

2.1 Utworzy¢ model przedstawiony na Rys. 3 wykorzystuj¡c nast¦puj¡ce bloki:

• Sine Wave - z biblioteki Sources;

• Integrator - z biblioteki Continuous;

• Derivative - z biblioteki Continuous;

• Mux - z biblioteki Commonly Used Blocks;

• Scope - z biblioteki Sinks.

2.2 Zapozna¢ si¦ z parametrami poszczególnych bloków (okno pojawi si¦ po dwukrotnym wy-
braniu danego bloku).

2.3 Zapisa¢ model w folderze utworzonym na poprzednich zaj¦ciach.

2.4 Uruchomi¢ symulacj¦ i zaobserwowa¢ wyniki w bloku Scope.
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2.5 Utworzy¢ funkcj¦ w m-pliku zwracaj¡c¡ wynik sumowania dwóch parametrów wej±ciowych.

2.6 Stworzy¢ model w Simulinku wykorzystuj¡cy funkcj¦ stworzon¡ w poprzednim punkcie. Wy-
korzysta¢ blok Matlab Fcn (biblioteka User-De�ned Functions). Jako parametry wej±ciowe
podawa¢ warto±ci staªe (dwa bloki Constant z biblioteki Sources), natomiast wyj±cie funkcji
przedstawia¢ za pomoc¡ bloku Display (biblioteka Sinks).

3 Eksportowanie i importowanie zmiennych

W przypadku niektórych modeli, konieczne mo»e okaza¢ si¦ wykorzystywanie wcze±niej zadeklaro-
wanych zmiennych, znajduj¡cych si¦ w Workspace Matlaba. Niezwykle wa»ne jest, aby zmienna,
któr¡ chcemy importowa¢ byªa zadeklarowana w przestrzeni roboczej programu Matlab. Ekspor-
towania i importowania zmiennych pomi¦dzy modelem Simulink a Workspace mo»na dokona¢ na
wiele ró»nych sposobów.

Pierwszy z nich polega na okre±leniu odpowiednich zmiennych w zakªadce Data Import/Export
(po wybraniu opcji Simulation→Con�guration Parameters w oknie modelu). Nale»y pami¦ta¢ o
tym, »e sygnaªy, które chcemy eksportowa¢ nale»y poª¡czy¢ z blokiem Out (biblioteka Sinks), a te
które chcemy importowa¢, z blokiem In (biblioteka Sources). W najprostszym przypadku, zmienne
importowane z Workspace powinny by¢ postaci wektorów kolumnowych.

Drugi sposób wymaga u»ycia bloków From Workspace oraz To Workspace, znajduj¡cych si¦
odpowiednio w bibliotekach Sources i Sinks. W przypadku importu danych w parametrach bloku
nale»y poda¢ nazw¦ zmiennych, które maj¡ by¢ importowane. Importowane zmienne równie» musz¡
by¢ wcze±niej zadeklarowane. Eksport danych wymaga podania nazwy struktury danych, która
b¦dzie przechowywa¢ zmienn¡ w Workspace (domy±lnie: simout). Aby uzyska¢ dost¦p do warto±ci
zmiennej nale»y odwoªa¢ si¦ do nast¦puj¡cego elementu struktury:

>�> simout.signals.values;

Przykªadowo, nadaj¡c nazwy t oraz u w blokach To Workspace, mo»na stworzy¢ wykres tych
zmiennych za pomoc¡ polecenia:

>�> plot(t.signals.values, u.signals.values);

Dodatkowo, model w Simulinku mo»e wykorzystywa¢ staªe zadeklarowane wWorkspace. Wystarczy
ich deklaracje w Oknie Polece« poprzedzi¢ sªowem global.

3.1 Przeksztaªci¢ analitycznie równanie ró»niczkowe do postaci operatorowej (przy zerowych
warto±ciach pocz¡tkowych):
ẍ+ 3ẋ+ 2x = u

3.2 Utworzy¢ model z wykorzystaniem bloku Transfer Fcn (biblioteka Continuous).

3.3 Przy zaªo»eniu, »e u jest sygnaªem prostok¡tnym o amplitudzie 1 i okresie równym 10s,
przeprowadzi¢ symulacj¦ modelu z parametrami domy±lnymi.

3.4 Przeksztaªci¢ schemat blokowy tak, by sygnaª wyj±ciowy x byª podª¡czony do bloku wyj±cia
(Out). W parametrach symulacji, na zakªadce Data Import/Export ustawi¢ eksportowa-
nie czasu i zmiennej wyj±ciowej do przestrzeni roboczej Matlaba, ewentualnie mody�kuj¡c
domy±lne nazwy zmiennych.

3.5 Przeprowadzi¢ symulacj¦ modelu. Wykre±li¢ przebieg sygnaªu wyj±ciowego x w czasie z
poziomu okna polece« Matlaba i porówna¢ z przebiegiem uzyskanym w modelu (blok Scope).

3.6 Zmody�kowa¢ schemat blokowy tak, by dodatkowo eksportowa¢ sygnaª u. Tym razem wy-
korzysta¢ blok To Workspace (we wªa±ciwo±ciach tego obiektu wybra¢ tablic¦ � array � jako
format eksportowania danych).
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3.7 Przeprowadzi¢ symulacj¦ modelu. Wykre±li¢ przebieg sygnaªu wej±ciowego u w czasie z
poziomu okna polece« Matlaba i porówna¢ z przebiegiem uzyskanym w modelu (w tym celu
mo»na na wyj±ciu bloku generatora sygnaªu wej±ciowego, umie±ci¢ dodatkowy blok Scope).

3.8 W przestrzeni roboczej Matlaba wygenerowa¢ zmienn¡ reprezentuj¡c¡ wektor czasu z caªego
horyzontu symulacji (np. t = [0 : 0.1 : 10]T ). Wygenerowa¢ zmienn¡ reprezentuj¡c¡ warto±ci
sygnaªu wej±ciowego dla wszystkich chwil symulacji (np. u = sin(t)).

3.9 Zmody�kowa¢ schemat blokowy tak, aby importowa¢ sygnaªy wej±ciowe z przestrzeni robo-
czej Matlaba za pomoc¡ bloku wej±cia (In). W parametrach symulacji, na zakªadce Data
Import/Export ustawi¢ importowanie warto±ci czasu i sygnaªu wej±ciowego u, ewentualnie
mody�kuj¡c domy±lne nazwy zmiennych na nazwy zadeklarowanych zmiennych.

3.10 Przeprowadzi¢ symulacj¦ modelu.

4 Zmiana parametrów symulacji

Przed uruchomieniem symulacji modelu, mo»liwe jest ustawienie opcji symulacji, takich jak po-
cz¡tkowa chwila symulacji, czas trwania, opcje importowania i eksportowania danych (zagadnienie
dokªadnej opisane w nast¦pnym rozdziale) oraz rodzaj caªkowania, którego Simulink u»ywa do
rozwi¡zywania modelu w ka»dej chwili czasowej. Ustawienie czasu symulacji mo»liwe jest na pa-
sku narz¦dzi (obok przycisku Stop Simulation). Aby dokona¢ zmian w opcjach symulacji nale»y
wybra¢ Simulation→Con�guration Parameters w oknie modelu lub nacisn¡¢ Ctrl+E. Podczas labo-
ratoriów z przedmiotu Podstawy Automatyki wykorzystywane b¦d¡ jedynie zakªadki Solver i Data
Import/Export.

Solver okre±la metod¦ numeryczn¡ do iteracyjnego rozwi¡zywania równa« ró»niczkowych zwy-
czajnych. Jest to komponent oprogramowania Simulink, który okre±la nast¦pny krok czasowy sy-
mulacji, który jest wymagany, aby uzyska¢ zde�niowan¡ przez u»ytkownika dokªadno±¢. Simulink
udost¦pnia szereg ró»nych rodzajów solverów, spo±ród których mo»na wyró»ni¢ solvery o ustalonym
kroku próbkowania i zmiennym kroku próbkowania.

Oba typy solverów obliczaj¡ nast¦pny krok symulacji na bazie sumy aktualnego czasu symulacji
oraz warto±ci okre±lanej jako czas próbkowania. W przypadku solverów o ustalonym czasie próbko-
wania, odst¦py pomi¦dzy wszystkimi krokami symulacji s¡ sobie równe. Inaczej zde�niowany jest
czas próbkowania dla solverów o zmiennym czasie próbkowania. W tym przypadku, czas próbko-
wania mo»e si¦ zmienia¢ w zale»no±ci od wªa±ciwo±ci dynamicznych modelu. W ogólno±ci, solver o
zmiennym czasie próbkowania, zmniejsza czas pomi¦dzy kolejnymi krokami symulacji, gdy zmiany
stanu modelu przebiegaj¡ szybciej (zapewniaj¡c jednocze±nie wi¦ksz¡ dokªadno±¢ symulacji) oraz
zmniejsza go, gdy zmiany przebiegaj¡ wolniej (pomijaj¡c niepotrzebne kroki symulacji, jednocze±nie
j¡ przyspieszaj¡c).

Podczas wyboru typu solvera nale»y uwzgl¦dni¢ czy wygenerowany kod b¦dzie wykorzystany na
rzeczywistym systemie. Je»eli planowane jest zaimplementowanie modelu na rzeczywistym obiekcie,
którego taktowanie zegara jest niezmienne w czasie, nale»y u»y¢ solvera o niezmiennym czasie
próbkowania. Symulacja z u»yciem solvera o zmiennym czasie próbkowania, mo»e spowodowa¢
pomini¦cie bª¦dów, które pó¹niej pojawi¡ si¦ na rzeczywistym obiekcie.

4.1 Dla solverów o ustalonym kroku caªkowania (�xed-step size) ustawi¢ warto±¢ kroku na 1 i
przeprowadzi¢ symulacje dla wszystkich dost¦pnych metod caªkowania, porównuj¡c wyniki.
Wykorzysta¢ model z poprzedniego rozdziaªu.

4.2 Dla solverów o zmiennym kroku caªkowania (variable-step size) ustawi¢ maksymaln¡ war-
to±¢ kroku na 1.1, minimaln¡ na 0.9 oraz pocz¡tkow¡ na 1. Przeprowadzi¢ symulacje dla
wszystkich dost¦pnych metod caªkowania, porównuj¡c wyniki.
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5 Tworzenie podsystemów i masek

Aby utworzy¢ podsystem w ramach gotowego modelu, wystarczy zaznaczy¢ te elementy, które maj¡
wchodzi¢ w skªad nowego podsystemu oraz wybra¢ Edit→Create Subsystem lub nacisn¡¢ Ctrl+G.
Dwukrotne klikni¦cie bloku podsystemu powoduje otwarcie nowego okna zawieraj¡cego schemat
podsystemu.

Mo»liwe jest równie» utworzenie maski podsystemu. Uªatwia to zadawanie parametrów dla po-
szczególnych skªadników podsystemu gromadz¡c je wszystkie na standardowym oknie dialogowym.
Aby mo»liwe byªo stworzenie maski podsystemu, bloki powinny zawiera¢ parametry okre±lone na-
zwami zmiennych (np. k1, Td) zamiast staªych warto±ci (np. 1, 20). Opcja tworzenia maski
dost¦pna jest w menu kontekstowym podsystemu pod Mask Subsystem.

W otwartym edytorze maski dost¦pne s¡ cztery zakªadki:

• Icon � pozwala okre±li¢ wygl¡d bloku reprezentuj¡cego podsystem. Do ikony bloku mo»na
dodawa¢ tekst, wstawia¢ rysunki czy rysowa¢ wykorzystuj¡c odpowiednie polecenia Matlaba;

• Parameters � pozwala okre±li¢ parametry de�niowalne przez u»ytkownika w oknie parametrów
podsystemu, które b¦d¡ powi¡zane z poszczególnymi skªadnikami; aby doda¢ parametr do
maski podsystemu nale»y klikn¡¢ przycisk Add, a nast¦pnie wypeªni¢ nast¦puj¡ce pola:

◦ Prompt � tekst który pojawi si¦ jako opis (nazwa) parametru;

◦ Variable � nazwa zmiennej, która b¦dzie reprezentowaªa parametr w podsystemie;

◦ Type � typ pola edycyjnego do wprowadzania warto±ci parametrów; dost¦pne s¡: edit
(linia edycyjna), checkbox (pole wyboru) i popup (lista rozwijalna);

◦ Evaluate � okre±la czy warto±¢ wprowadzona przez u»ytkownika ma by¢ obliczana jako
wyra»enie Matlaba czy dosªownie przypisywana zmiennej jako ci¡g znaków;

◦ Tunable � okre±la czy parametr mo»e by¢ zmieniany w trakcie trwania symulacji.

• Initialization � pozwala okre±li¢ operacje inicjalizuj¡ce parametry podsystemu. Operacje te,
które mog¡ by¢ dowolnymi wyra»eniami Matlaba, s¡ wykonywane przy ªadowaniu modelu i
uruchamianiu symulacji;

• Documentation � umo»liwia wprowadzenie opisów podsystemu, które pojawi¡ si¦ w zwi¡za-
nym z nim oknami parametrów i pomocy; na tej zakªadce dost¦pne s¡ trzy pola:

◦ Mask type � tekst wy±wietlany jako nazwa pola opisu podsystemu w oknie edycji para-
metrów;

◦ Mask description � opis podsystemu wy±wietlany w oknie edycji parametrów;

◦ Mask help � opis pomocniczy podsystemu, wy±wietlany po naci±ni¦ciu przycisku Help
na oknie edycji parametrów.

Dwukrotne klikni¦cie bloku regulatora spowoduje wy±wietlenie zde�niowanego okna parametrów.
Dost¦p do edytora maski jest mo»liwy po wybraniu z menu kontekstowego bloku podsystemu po-
zycji Edit mask. Dost¦p do schematu blokowego podsystemu jest mo»liwy po wybraniu z menu
kontekstowego bloku podsystemu pozycji Look under mask.

5.1 Utworzy¢ model przedstawiony na Rys. 6. W celu zmienienia liczby sygnaªów wej±ciowych
bloku Scope, nale»y dwukrotnie nacisn¡¢ na niego lewym przyciskiem myszy. W nowo
otwartym oknie wybra¢ z paska narz¦dzi Parameters oraz okre±li¢ Number of axes.

5.2 Zaznaczy¢ wszystkie bloki Transfer Fcn wraz z poprzedzaj¡cym je w¦zªem zaczepowym i
utworzy¢ podsystem o nazwie Obiekty.

5.3 Utworzy¢ mask¦ podsystemu, umo»liwiaj¡c¡ ustawianie warto±ci parametrów k1, k2 oraz
k3.
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Rysunek 6: Drugi przykªadowy model Simulinka.


